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Spend
Less.
Yeah, looks matter. We live in an intense visual age where print publishers are competing
for eyeballs with a zillion images on phones, tablets, laptops, smart TVs, you name it. To
get noticed, to be relevant and to be profitable you need to stand out, make a statement
and grab readers with compelling design.
If your publications look like 1982 or 1992 you’d better fast-forward soon to 2022. We can
make your newspapers and magazines snap, crackle and pop – getting them the attention
they need and deserve. Make your content pretty and compelling – a must-read. When
you do your design with us, a modern redesign is no extra charge. Your print and web
ads will look a world better. Better designed ads get more readership which leads to more
response and that makes for happier advertisers who’ll spend more money with you.
The best part? You can save 50-75% versus the cost of doing your pages and ads in-house or
even with local freelancers. World-class art direction at a fraction of the cost. You also get:

 FREE unlimited spec ads.
 FREE changes and corrections.
 FREE charts and infographics
to embellish your stories.
 FREE stock photography.

 FREE e-book files.
 FREE posting and uploads to your CMS.
 FREE design of your promotional,
marketing and media kit materials.
 AND MORE!

It’s our 18th year serving more than 300 newspapers and magazines each week. 100 fulltime, highly-talented designers will make you look great and save you a bundle. Tons of
references available.

We Make Publishing Prettier and More Profitable.
Call Howard Barbanel today at 516-860-7440 to get started.
Howard@Design2Pro.com • Design2Pro.com
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FROM THE TOP

WALK IN ANOTHER’S SHOES

A
JOHN DRAPER
ACP PRESIDENT
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s an owner of a small business
it’s not uncommon to have to do
a little bit of everything. This is
natural to the position and a requirement that I think is necessary. I don’t
think the operation runs optimally if the
owner doesn’t have a good understanding
of the various duties performed within the
company. Given the ups and downs of the
business word and the fact that we simply
cannot afford to be over-staffed, successful
operations require that business owners,
and other employees, are able to perform
various duties and fill-in where necessary
to get the job done.
What I state above is no revelation. This
is commonplace and has been for years.
However, with the changes we’ve seen
over the past two years I think we are now
realizing even more how dependent we
are on strong employees and how necessary it is for everyone to spend some time
in another person’s shoes. Walking in the
steps of another can open our eyes to better understanding and appreciation.
For two years I’ve spent a lot of time in
the shoes previously filled by our Managing Editor. By no means have I filled these
shoes. She was fantastic and provided leadership in the newsroom that didn’t require
me to actively manage day-to-day operations of the department. That was a bit of a
luxury; a luxury that now gone has created better appreciation for what she did
and for what our entire news staff does.
Similarly, others within the newsroom have
also walked in her shoes. This has provided growth opportunities for them and
generally improved total operations.
Just last month, for a period of two
weeks, I walked in the shoes of our sports
editor. As a photographer and writer he’s
one of my region’s best. Again, some big
shoes to fill. Fortunately, the walk was relatively short and soon enough, after some
less than standard sports sections, things
were back to normal.
As I write this, I’ve spent large portions
of the last week walking in the shoes of
our graphics department. One employee
has been out with an ill family member

and we recently took on a number of
large projects that have been taxing to the
group. (I like the revenue of course).
While seeing the world through a sports
writer’s shoes, I am reminded of all it takes
to perform the job. I see the events as
enjoyable, but also as work. I see the hours
it takes to travel, analyze the game, shoot
a bunch of photos in the hope of getting
at least one passable shot, and then the
follow up to construct a story and put it to
press. I’ve never taken all of this for granted, but to see/live it for two weeks reminded me of what he does and all the tasks
that go into the job. I’ve created a deeper
understanding and appreciation.
Likewise, my time in the graphics
department has opened my eyes to all
they do. I’ve seen first-hand the less than
desirable instructions coming from the
sales team. I’ve had to react to a last minute sold ad, and unfortunately, the holes
left when an ad cancels near the end of
pagination.
So, “where is this going?” you ask. These
are just some examples in my immediate
work and life that remind me to be diligent about seeing issues and tasks through
someone else’s eyes. Every day we have
experiences or opportunities to stop and
consider what others might be going
through or where they are coming from
on an issue. These are real-time opportunities to understand and appreciate.
Far too often we are quick to criticize.
If things don’t go well for our designers, do
we criticize their reactions, or think about
what might have happened in the sales
department to create the issue? Further, do
we criticize the sales rep, or consider what
may have driven the advertiser to pull that
promotion? Or, do we stop to evaluate what
it’s like to walk a day in their shoes?
We all live our lives and have our priorities that must be met. This makes it
easy, and somewhat natural, to be inward
focused. I’m guilty. But being diligent to
acknowledge the efforts of those we rely
on and to take a view from their shoes,
can help us broaden our minds and move
forward productively. 

THE ONE THING

KEEP ROLLING

E
BY DOUGLAS FRY

very Sunday morning around
8:00 a.m. I meet a friend for a
bicycle ride. My riding partner
is named Ben. He is not as fast
as he once was but he does his best
to ride along quickly. Though the
pace is leisurely I get more from our
rides than the physical. After each
ride I feel grateful, motivated, and
inspired.
Ben is not a motivational speaker
or sports guru. He’s just a 30 year old
riding a bike. Maybe we should go
back three years to understand why
this man fills me with such respect.
Three years ago I was riding with
Ben on beautiful country roads
around the county. We approached
a bridge across the Duck River. He
disappeared around a bend in the

road leading to the crossing. When
I rounded the corner I saw Ben
sprawled across the asphalt. He was
not moving. I went to his side and sat
in the road with him. It took nearly
an hour for emergency vehicles to
get to the site. During that time Ben
kept asking the same three questions
over and over, “How did I get here?”
“Where is my girlfriend?” and “Is my
bike alright?”
As I sat with Ben in the middle of
the bridge he did not move once.
That scared me. My First Aid merit
badge training taught me not to lift
or alter the position of an accident
victim unless it was to save their life.
So, I just sat, listening to his questions, answering them again and
again, hoping he had merely suffered
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THE ONE THING
a concussion. When the paramedics
finally arrived I moved from his side
and hoped for the best.
Ben was airlifted to Vanderbilt
Hospital. We cut the remainder of the
ride short so we could process what
had just happened. The next day I
went up to Nashville to visit Ben. He
was in the ICU with his parents at his
side. They gave me the news I anticipated but hoped against: Ben was
paralyzed below his waist. Ben began
rehab and endured many attempts
to get his lower limbs to respond to
stimuli. No improvement happened.
So, he learned to use a wheelchair, to
get dressed, to drive a van with only
his hands, how to get around with
challenges in a world that ignores the
possibility that some people might be
different.
He was let go from his job as a
heating and air conditioning technician at a very large grocery chain.
They decided they didn’t need a par-

alyzed technician so they fired him.
I won’t tell you the name of the chain
as it might prejudice you against
them. But the name of the grocery
chain rhymes with “Troger.”
In spite of the accident, Ben
learned to ride a three wheeled bike.
He uses his hands and arms to pedal,
shift, steer, and brake. But that’s not
the motivating part. What impresses
me most about Ben is that, in spite
of the huge challenges he faces
for the remainder of his life, he is
positive and happy. He can poke fun
at himself and enjoys a good laugh.
He has also taken up indoor rock
climbing and just participated in the
national competition. He placed 4th.
Ben’s favorite saying he learned from
the climbing tournaments is “Trust
your legs.” Remember, he hasn’t felt
anything below the waist in nearly
three years.
As we ride along on Sunday mornings Ben talks about the future, about

Audits & Readership Studies for additional
publications you own at ACP rates!
Enjoy the same
great data and
CVC benefits for
Bridal, Parenting,
55+ Lifestyle,
Home,
Business, or
Niche Guides
that you also
publish.

Call now to get started! (314) 966-7711
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competing with others and himself,
and how much he appreciates everything we all take for granted. He
makes me laugh. His outlook helps
me think about what really matters
in life. He helps me see that I am one
lucky guy. I’m lucky to have a friend
like Ben. It is said that “Comparison
is the thief of joy.” In this case comparison is the catalyst to recognizing
all the advantages I have.
One morning I asked him how he
is able to maintain such a positive
outlook in the face of the reality of
his challenges. He replied that “Sometimes in life we just have to keep
rolling no matter what the road looks
like ahead.”
So, that’s the One Thing this month.
No matter what challenges we might
face I recommend that we all simply
“Keep Rolling.” We don’t know what
is just around the corner and that’s
what makes life so interesting and
fun. Roll on. 

PERSPECTIVE

MULTICHANNEL MARKETING
BY LOREN COLBURN

A

s I write this month’s Perspective, I realized that today
marks the 45th anniversary of
the day I entered my fulltime
career in the community publication
industry. Victor Ianno (NAAP President and Publisher of the Year in the
70’s) gave me an opportunity fresh
out of college and it has been an
amazing ride ever since. A great deal
has changed in the industry over that
period, both in the media landscape
and the local advertising perspective.
In thinking about this issue’s
focus on “Revenue Opportunities”,
I couldn’t help but consider one of
the more significant changes I have
seen in the perception of advertising
buyers through the years. I remember when selling any kind of a new
product was an absolute uphill battle.
The number of times I heard the “let’s
see how the first issue goes and then
we’ll consider it down the road” response was discouraging. Regardless
of if it was a new edition, a special
section we had not done before or an
in-paper promotion, many advertisers
were skeptical about trying anything
new. If they did consider it, they
needed to know the exact location of
the homes to be delivered, the total
circulation and exactly what day it
would be hitting the street.
Fast forward to the post 2000 advertising world and suddenly advertisers will readily jump to buy a digital advertising product that has no
geographic component, no verified
receivership or viewers, and a completely open-ended timing. Not only
will they not ask any critical questions, they buy it and get genuinely
excited about this new shiny opportunity they know very little about. On
top of that, they are convinced they
are getting a great deal! Advertisers
quite often end up disappointed with
the results produced, but that does

not seem to deter them from grabbing the next digital proposal that
comes along in hopes of finding the
magic formula for marketing success.
So how do print products face this
new search for trendy advertising
programs that produce the good old
fashion results like they did “back in
the days” of coupons and super sales?
I believe publications need to actively package enough of the shiny new
digital to meet advertiser expectations
and marketing tends while incorporating enough proven print advertising
techniques to drive a level of response
the advertiser drastically needs. The
digital ads can point to the more
detailed print components, increasing
exposure to the advertiser’s message
(as well as building your publication’s
readership). Advertisers win, publications win and consumers build awareness and response. All too often I see
community publishers tending to fight
digital rather than embrace it.
Here are some simple points your
advertising packages and advertisers
should keep in mind based on a 2019
study by the USPS Office of the Inspector General related to advertising
effectiveness and age. (links provided
at the end of the column)1, 2, 3
• Results showed that regardless of
age, physical ads were more effective than digital in leaving a lasting
impression.
• All age groups processed digital
ads more quickly than physical,
which can be advantageous with
limited attention or time.
• Physical ads elicit more emotional
reaction to an ad than digital.

• Physical ads develop more subconscious desire for the product or
service than digital ads
• The subconscious value a participant places on the product or
service is higher with physical ads
than with digital ads
• Consumers will spend more time
with a physical ad than a digital ad.
In summary, utilizing digital ads to
draw attention to a business, product
or promotion can be an effective way
of increasing exposure and response
for your advertiser. Having digital
point to the print ad and the print ad
include information on how to easily
find the website will assure a maximum audience for each marketing
message. Digital has it’s limitations,
but it also has its strengths and like it
or not – it’s here to stay. Publications
can incorporate those digital benefits
with the results producing strengths
of print advertising and deliver promotional packages for advertisers
that are far more successful than digital only or print only campaigns.
Don’t be afraid to try new promotions and publication content ideas.
Advertisers and consumers are both
more receptive than ever to new
products and offerings and it’s up to
you to find new ways to take advantage of this trend. Your products
need to reflect the trends in your
market and embrace every opportunity that presents itself. Changes
seem to come at an accelerated rate
as time goes on but that just means
we need to be much quicker to
identify the changes and determine
the best way to react and exploit the
opportunities those changes create.
If we react correctly, we can take
advantage of every opportunity to
reinforce “If it’s free, buy it!” 
https://www.uspsdelivers.com/
why-direct-mail-is-morememorable/#identifier_4_123
2
https://www.uspsoig.gov/document/
advertising-effectiveness-and-age
3
https://www.uspsoig.gov/sites/
default/files/document-libraryfiles/2019/RARC-WP-19-001.pdf
1
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SCHOLARSHIPS

BOB WRIGHT SCHOLARSHIPS
FOR 2022 ANNOUNCED
BY DEBORAH PHILLIPS, BOB WRIGHT MEMORIAL SCHOLARSHIP CHAIRPERSON

T

his year we received 12 applications for the Bob
Wright Memorial Scholarship. We had only $6,100
to award. The hard part is that this isn’t the easiest
scholarship for which to apply. There are a lot of
pieces that need to be pulled together for the application. So, when we cannot award everyone $1,000 towards

education, it is always a difficult decision. We decided to
award six recipients, so the committee made the decision
to award $1,000 to each of them.
The 2022 recipients are Katelyn Piersma, Olivia Schwartz,
Sofia Panlilo, Malana Thompson, Kiana Marti and
Adam Greene.

KATELYN PIERSMA will graduate this year from Otsego High
School. She is ranked third in her
class of 151 students. Music is a
big part of her life. She was a drum
major in the marching band and
participated in Symphonic Band,
Pep Band, Jazz Band and several
musicals. She was a member of
National Honor Society, Students
Against Destructive Decisions, and
Jump Start. She plans on attending the University of Michigan in
the Fall. Along with being an AP
Scholar, she has been a dishwasher,
fireworks salesperson and a waitress. Her mother is Pamela Piersma
who works for Community Shoppers Guide in Otsego, MI.

KIANA MARTI is a sophomore
at West Chester University. In high
school she received her International
Baccalaureate Diploma in 2020. She
was a member of the Spanish Honor
Society, and did Varsity women’s soccer, link crew and the bowling team.
In college she is currently an Integrative Biology major and a Psychology
minor. After she earns her bachelor’s,
she is planning to continue school
to become a Physician Assistant. In
addition to her job as a cashier, she
sources and sells clothing accessories and shoes from vintage shops
and thrift stores. Her grandmother is
Pamela Hildebrand who is employed
at Engle Printing & Publishing Co. in
Mount Joy, PA.

OLIVIA SCHWARTZ was first in her class of 464
students. She is currently a college sophomore
at Montana State University in Billings, Montana.
In the summer after her freshman year, she was
accepted into the CPING Research Experience for
Undergraduates where she did research and conducted a project which observed the morphology of
Convolvulus arvensis across Billings, Montana. After
this she was invited to share her research with
other students who were studying plant invasion
genomics. Her other activities include club volleyball for which she received an athletic scholarship.
Her mother is Helen Boyd-Schwartz who works at
Exchange Publishing in Spokane, WA.
10
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SCHOLARSHIPS
SOFIA PANLILIO will graduate this year
from Smith Academy where she currently
ranks first in her class of 45 students. She has
earned most outstanding in French, Biology
and English, along with multiple awards in
high school band competitions in New England. She is also a member of the National
Honor Society. Her other activities include
Youth Music Ministry Assistant, Library Teen
Volunteer and Historical Society volunteer.
She plans to attend Union College in the fall
to study Computer Science and Cybersecurity.
In her junior year, she took Computer Science
and coding courses at Smith College. And in
her senior year she was offered a TA position
in the middle school where she enjoyed sharing her knowledge of coding with the younger
students. Her parent, Curtis Panlilio, works at
The Reminder in East Longmeadow, MA.
MALANA THOMPSON will
graduate this year from Albert Lea Senior High School in
Minnesota. She ranks 39th in her
class of 203 students. In addition to being a member of the
National Honor Society, her
activities include hockey, soccer,
well being club, student council,
key club and book club. She is
a member of the church council
and a volunteer at the humane
society. She is planning on attending Bethel University in the
fall and go into the medical field.
Her parent is Julia Thompson
who is the publisher of the Freeborn County Shopper in Albert
Lea, Minnesota.

WE MAY BE “CHEEP”,

ADAM GREENE will graduate this year
from Longmeadow High School. His activities include vice president of the investment club, indoor and outdoor track
and National Honor Society. His plan is
to attend the UMass Isenberg School of
Management in the Fall. He currently
writes sports articles and is committed
to exploring more in the field of Journalism and sports management. According to one of his recommendations,
Adam is an exceptional young man. His
warmth, character and interest in sports
broadcasting and journalism sets him
apart from the crowd. His parent, Scott
Greene, is employed at The Reminder in
East Longmeadow, MA.
Proud to be the expert media financial valuation resource for
the FORBES 400 List of America's Richest People 2015 - 2022

BUT WE DARE YOU TO
COMPARE US WITH
THE EXPENSIVE GUYS.
Schedule a Zoom demo at your convenience and
let us show you how to save some scratch.
Call for more information:
207.452.2476 or 978.580.1895
100 Domino Drive, Concord MA
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REVENUE OPPORTUNITY

THREE EASY WAYS
TO ADD DIGITAL REVENUE
TO YOUR PUBLICATION

J

anuary Spring works exclusively
with publishers to help them
earn digital revenue. We do the
digital market heavy lifting. Some
of our publishers earn six figures in
digital revenue and you can too.
One of the reasons we work with
publishers is that they have amazing
brands. They are all well recognized
in their community and well respected. We partner with them and do
the digital heavy lifting with a whole
catalog of digital offerings.
Here are three easy ways to make
quick digital revenue for your publication:

1. EVENT TARGETING
We can target any event with our
digital geofencing techniques. For
example, a bridal expo would be
a popular event target, especially
this year. According to the Wedding
Report, 2.5 million weddings are expected to happen this year, the most
since 1984.
First our team can put together
a pre-event targeting campaign by
serving ads to those in the area using
keywords related to the event. Second, our team can geofence the wedding expo and serve ads to those that
attend during the event. Third, we
can collect device ID’s of those that
attended and serve them your client’s
ads for up to 30 days after the event.
Our event playbook can increase
industry event attendance by as much
as 35% and get you digital ad revenue.

2. CATEGORY SPECIFIC ADS
Tell the story about what digital ads
can do for your advertisers. Restaurants, for example, can use a restaurant category and serve ads to those
12
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looking for places to eat and to those
that dine at your competition with
our geofence technology. The results
speak for themselves with this type
of campaign.
Our conversion and Click Through
Rate are usually double the industry
standard. Everything we do is fully
transparent, and you will be able to
provide clients links to our reporting
dashboard. The dashboard tracks
clicks and conversions as the campaign is going.
Let us tell you the story of a Mexican Restaurant that used some of
our tactics and got bit results. This
restaurant geofenced all of its competitor and we were able to serve ads
to those that entered those geofences.
They also set up a conversion zone
around their restaurant to see what
restaurant had the most foot traffic
(this restaurant had more than one
location). The restaurant could keep
track of who saw their ads and who
walked into their restaurant and what
restaurant they went to.

This restaurant also used keyword
targeting and website retargeting. This
restaurant also worked with us to set
up a curated audience in a specific
zipcode. Because this restaurant want
to be know as family friendly, they
targeted all households with children.
Ads with a click through to the daily specials was also very effective.
We got results:
Over the five-month-long campaign,
the ad earned the restaurant chain
205,640 impressions, 309 clicks and
72 conversions, and that was customers that walked through their door!

3. DON’T FORGET ABOUT
USING YOUR OWN AUDIENCE
TO TARGET.
January Spring is a digital marketing agency that works exclusively
with publishers to help them take
digital off-site services to market. Reach out and we will gladly
share our Playbook. Contact us at
contact@JanuarySpring.com

REVENUE OPPORTUNITY

REVENUE OPPORTUNITIES?
THE FORCE IS WITH YOU
BY METRO CREATIVE GRAPHICS

I

f we were all Jedi Masters, we
could wave a hand in front of clients and proclaim, “These are the
ad packages you want to buy.”
Alas, many of us have not reached
that enlightened state, but when it
comes to revenue-generating opportunities, your prospects are looking
to you to be their Jedi Masters to get
them the results they want and need.
Within those interactions lies the
basis for thinking about revenue-generating opportunities. That is to say, if
you gear your revenue-building ideas
toward helping your prospects grow
their revenue, you'll also be helping
your own bottom line.
There are many ways to approach
thinking about revenue creation. Metro Creative Graphics is a company
that has been around for 112 years
now, sharing in the ebb and flow of
ideas that help shape ad sales. The
entire concept of revenue-producing
opportunities at Metro is the “what's
for dinner?” question of the day.
In that position, the company holds a
unique viewpoint on what is happening in the world of ad publishing.
Lately, a few trends are rising that
may be avenues for you to consider:
EMERGENCY PREPAREDNESS
SECTIONS
The increase in natural disasters
from coast to coast in recent years
has renewed the national appetite for
information on how to keep families
safe before, during and after extreme
weather events or other disasters.
The News Journal of Wilmington,
Ohio, has been publishing an annual
Emergency Preparedness & Response
section for many years. This year, in
addition to the print component, the
publication issued it as a web e-section with a six-month run. Ad spots
ran in place alongside features, ranging from a disaster supply kit check-

Lifestyle photos, such as these supplied by Metro,
can be the creative impetus to finding untapped revenue opportunities.

list to a directory of local emergency
numbers. The section gives advertisers
staying power and readers a valuable
reference. To expand the reach of the
material, the publication developed
it as a group project with two other
publications in neighboring counties.
THEMED PACKAGES
An area that is ripe for revenue opportunities is themed selling. Whether
the topic is based on a seasonal event
or other concept, the possibilities for
expansion are numerous. A themed
package may be carried from a section
to campaign ads to themed pages to
online e-sections and pages. For example, a “shop local” angle may embody
your support for area businesses with
a print section. Drill down deeper into
the theme and there are categories
within the concept that offer huge
potential for themed pages that can
carry on programs for months, if not
throughout the year. You may find a
large percentage of regional business
owners are veterans, so an instant
connection is made for events like
Military Appreciation Month in May or
Veterans Day in November. Statistics
show that women are increasingly
becoming entrepreneurs of brick-andmortar establishments, opening the
door for a subset of your “shop local”
coverage dedicated to women-owned
businesses. The point is, you don't

always have to think about a single
ad when you are generating ideas.
Expand and multiply.
POST-COVID SPENDING TRENDS
Much has been said about spending
trends in our mid-Covid environment.
Consumers forced to stay home more
often over the past two years spent
the majority of their available income
on their homes. Now there are indications of a pent-up demand for travel,
personal experiences and personal
services, according to most prognosticators. Seek the advertisers that
supply these goods and services, and
open up new revenue opportunities.
VISUALIZATIONS
Try a creative exercise with photographs to assist in discovering revenue opportunities. The idea is to get a
photo from a subscription service and
examine it through the eyes of your
prospects. Lifestyle photographs –
photos of real people in real-life
situations – are good candidates for
this exercise. For example, a photo of
family outdoors with a pet can possibly be an illustration for any number
of advertisers, from fashion to pet
care, family health to lawn care, and
any number of other retailers. Metro
subscribers can use “lifestyle” as a
keyword to discover a wide selection
of these types of photographs.
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REVENUE OPPORTUNITY

Track everything

with sales:

Advertiser emails, Bills,
Marketing, Forecasts and Proofs

303-791-3301
FakeBrains.com

The News Journal of Wilmington, Ohio, found a revenue opportunity
by partnering with publications in neighboring counties
for an Emergency Preparedness section.

The world is filled with Death Stars looking to destroy
or delay your efforts to find revenue-making opportunities. Anything from increased internet competition
to ad-budget reluctance on the part of potential advertisers, and everything in between, can seem to present
nearly insurmountable barriers at times. Use the Force –
your creative abilities to suggest revenue-generating
paths – then partner with advertisers to get them results, and you'll both benefit. Cue the music, and count
your Jedi income.
Explore more ways Metro can help your sales team
identify and capture every available revenue opportunity
at metrocreativeconnection.com. 
About Metro Creative Graphics, Inc.
Metro has been helping local publishers create, sell
and profit for 112 years with a spectrum of revenue
development services that have evolved to meet dynamic changes in the newspaper industry. These offerings
include spec ads; editorial features; stock images;
themed special sections; sales tools and training; digital ads, sites and directories; and more strategic tools
to support sales and creative teams.

Membership has its benefits - benefits you need!
EDUCATIONAL
PROGRAMS

REVENUE
IDEA SHARING

CIRCULATION
AUDITS FROM CVC

INDUSTRYWIDE
NETWORKING

TLI CLASSES
PROFESSIONAL
CERTIFICATIONS

IDEA EXCHANGES
OPEN PUBLISHER
DISCUSSIONS

BI-ANNUAL
CIRCULATION
AUDITS

VIRTUAL AND
IN-PERSON
EVENTS

Association of
Community
Publishers
AND MUCH MORE
JOIN TODAY!

Association of Community Publishers - 877-203-2327
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OBITUARIES –
BUILDING REVENUE AND READERSHIP
BY DEVLYN BROOKS

T

he most reliable data tells us
that obituaries still produce
hundreds of millions of dollars in revenue for newspapers
nationwide.
And just as importantly, consumers
still consistently rank obituaries as
their most favorite content type.
So, community publications would
be wise to invest time and intention
to maintain a healthy obituary vertical in their communities.
Letti Lister, the publisher of the
Black Hills Pioneer in Spearfish, S.D.,
admits that for years she took the
obituary vertical for granted. That’s
before she partnered with Modulist, a
media services company specializing
in the processing of user-generated,
community content such as obituaries, among other content categories.
In a January webinar that Modulist
hosted, Lister said that after just six
months on the platform, her obit
revenue had increased by 48 percent
because she started to receive obits
from funeral homes she previously
was missing. The increase was a direct
result in investing time in the relationship with her area funeral homes, and
matching that with the right, easy-touse tool for funeral homes to use.
“We were losing too many obituaries and the revenues they could have
generated. What I first liked about
Modulist is (that) all the people there
come from a newspaper background.
They understand the inefficiencies
of processing obituaries,” Lister said.
“With Modulist, families and funeral
homes can upload obituary text and
photos themselves. Modulist’s staff
verifies, edits and prepares the obituaries for us.”
Carol Toomey, president and publisher of the Action Unlimited group
of publications in Massachusetts, realized that when Gannett announced
the elimination of six printed newspapers in her communities, that she
not only had a business opportunity

drop into her lap, but she also had
to give her communities the printed
outlet to remember their loved ones.
She’s now enlisted the services of
Modulist to give her readers a cutting-edge online platform to customize their loved one’s obituary and to
inform the community of this person’s passing.
“This is a vital service to our community,” Toomey said. “If we don’t
provide this service to the community, who will?”
But you don’t have to be an expert
in obituaries for your publications to
benefit. You just need a knowledgeable partner.
Modulist’s tagline is “Publish life’s
stories” because its mission is to
match people and businesses wanting
to publish vital community content in
their local media products. Important
local stories such as obituaries.
Modulist does this with a worldclass online portal where clients submit their content, such as obituaries
and death notices – but also business
announcements, classifieds, letters
to the editor, and milestones such
as birth, engagement and wedding
announcements – sent directly to one
or multiple media outlets through a
single transaction.
Being Modulist is a portal open for
business 24/7, customers can access
the platform at their convenience.
Families and funeral homes can upload obituary text and photos themselves. And consumers see real-time
pricing, publication dates, deadlines
and all the other pertinent information to place an obituary in your
publication.
Once they have finished their loved
one’s obituary, they will be able to
double check everything before choosing their desired payment option.
Additionally, users can make changes
to their loved one’s obituary by just
logging into their account before the
obituary is published in the paper.

Finally, Modulist's staff verifies,
proofreads and prepares the obituaries for publications.
“I wish Modulist would have been
around 10, 15, 20 years ago,” said
Todd Keute, who publishes three
community newspapers in Blackduck, Bemidji and Park Rapids, Minn.
Keute says that the importance of
Modulist goes beyond just providing
an easy-to-use, self-service portal. Even
more important is the Modulist staff’s
focus on maintaining the important relationships between a publication and
its local funeral homes, which is the
real secret to obituary revenue.
“I don't look at Modulist like a vendor, I look at much more like a partnership,” Keute said. “What Modulist
offers in the way of services is what
we expect from our own employees.”
While it’s true that there will be a
continual shift in how community
news gets distributed. There is no
disputing what community content
consumers are looking for. Community publications that are thriving
continue to provide news about
the people in their community. And
providing a platform where people
can memorialize their loved ones
will continue to drive readership and
serve a vital community service.
“We generate significant revenues
from obituaries alone each year with
the assistance of Modulist,” said
Kelly Boldan, the editor of The West
Central Tribune in Willmar, Minn.
“Modulist simplifies the process for
funeral homes by providing one-stop
placement opportunities to multiple
newspapers. Obituaries are content of
great interest to communities and provide an opportunity for newspapers to
monetize it for maximum revenues.”
“Our mission is to establish a longterm partnership with our clients,
helping to position them for the
future by decreasing production costs
and increasing revenue,” said Modulist President Devlyn Brooks. 
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SPECIAL PROMO SHOWCASE

B

ased on the understanding that publications are always searching for more solid revenue producing promotions
that they can add to their current rotation, we have selected a couple that were produced by current members.
These promotions caught our eye in this year’s Best of the Best Awards judging and thought we would pass
them along to our Publish readers. They are easily adaptable to any market size, demographic and region.
Look them over and hopefully they will spark a new revenue source for your publications.

HOW-TO GUIDE
Cityview – Johnston, IA

PROMOTION DESCRIPTION: This special in-paper section included sponsored “how to’s” that cover a broad range of advertiser topics all the way from
“how to choose where to give birth” to “how to choose a tattoo studio”. Each
How-To is a half page ad below a half page of editorial (or aditorial) that details how to make the right selection in the advertiser’s core business area. The
topics are driven by advertiser support and could accommodate just about any
business type. To illustrate the versatility this promotion can include for an endless souce of business categories, those included by Cityview for 2021 were:
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•

How to choose where to give birth – sponsored by UnityPoint Health
How to choose a place to get pierced – sponsored by Prysm Piercing
How to choose a swim school – sponsored by Natavi Swim School
How to choose and allergist / immunologist – sponsored by Iowa Allergy Clinic
How to buy and sell coins – sponsored by Christopher’s Rare Coins
How to make a plan for after death – sponsored by Abedroth Russell Barnett Law
How to choose a lasik provider – Wolfe Eye Clinic
How to choose a mattress – Homemakers Furniture, Mattresses & Accessories
How to choose home décor – Homemakers Furniture, Mattresses & Accessories
How to choose a medical clinic – sponsored by UCS Healthcare
How to choose the best mortgage – sponsored by Fidelity Bank
How to choose a credit union – sponsored by Veridian Credit Union
How to choose a tattoo studio – sponsored by Lucky Gal Tattoo
How to choose a plastic surgeon – sponsored by Heartland Plastic Surgery
How to choose a therapist – sponsored by SS Therapy and Consulting
How to choose an accounting firm – sponsored by The Vroman Group
How to choose a primary care provider – sponsored by Unity Point Clinic
How to choose a music teacher – sponsored by Central Iowa Music Lab
How to choose an HVAC company – sponsored by Midwest Comfort
How to keep your smile bright – Lawson Family Dentistry

PROMOTION DETAILS
•
•
•
•
•
•
•
•

Timing: August (adaptable to almost any month)
Pages Produced: 21 Pages
Format: 12.25” magazine format / process color all pages
Stock: premium newsprint
Circulation: 30,000 printed copies plus 6,700 digital distribution
Ad Count: 19 local advertisers
Total Revenue: $12,901for 2021
Years Produced: 4 years

PUBLISHER COMMENTS: originally bought the content from Green Shoot
Media and then have added to it as needed for categories that were not part of
the original package.
18
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SMALL BUSINESS
SATURDAY
Fillmore County Journal –
Preston, MN

PROMOTION DESCRIPTION: This special section inserted in full run
of the paper promoting Small Business Saturday, buy local and the local
merchants. The perfect kickoff to the holiday shopping season promotes
top-of-mind awareness of the local area businesses headed into this
important sales period. This promotion also lends itself to both retail
and service businesses and is the ideal opportunity to partner with local
chamber of commerce groups. The promotion concept itself could be
easily adapted to any format (magazine, tabloid, broadsheet, etc.) and any
distribution means (in-paper, insert, sperate distribution) that would work
best with your publication or market. Although the timing is tied to Small
Business Saturday, the Saturday after Thanksgiving, the additional national marketing offered by companies like American Express help build
awareness and excitement for this event.

PROMOTION DETAILS
•
•
•
•
•
•
•
•

THANK YOU

to all of the participants of the

$1,000 LOCAL gift card giveaway!

On Tuesday, December 14, 2021, we conducted
a drawing from more than a 1,000 entries.
Below are the 10 winners, who will each receive $100 in gift cards
from five local businesses they selected on their entry form.

• NICK NELSON
Preston, MN
• BOB WICK
Rushford, MN
• BONITA HEIDTKE
Fountain, MN
• LEROY DUXBURY
Wykoff, MN
• CAROL JEAN KOHN
Spring Valley, MN

• SHIRLEE LENSER
Caledonia, MN
• NANCY SEFTON
Canton, MN
• LINDA ALDER
Chatfield, MN
• HELEN RAAEN
Lanesboro, MN
• DOROTHY KIEHNE
Chatfield, MN

Thanks to all of the contest participants and thanks to the
local businesses in each of these communities.

#ShopLocal #ShopSmall
#SupportSmallBusinesses

“Where Local News Comes First”

Timing: Issue prior to First Saturday after Thanksgiving
Pages Produced: 32 Pages
Format: 16” tabloid format / process color all pages
Stock: standard newsprint
Circulation: 19,000 printed copies
Ad Count: 122 local advertisers
Total Revenue: $9,988 for 2021
Years Produced: 5 years

PUBLISHER COMMENTS: This promotion has evolved in many ways.
We publish stories about businesses in the majority of communities we
serve. We run a full page ad in the section telling readers they can select five of their favorite businesses they would like to receive $20 gift
cards from. We conduct a drawing for $1,000 (10 winners each receiving
$100 in gift cards from the local businesses they selected with their entry
form). We usually receive somewhere between 1,500 and 2,000 entries.
This promotion is great and well supported by advertisers, because it promotes shopping locally and they stand the chance of getting some of their
investment in the advertisement back immediately if any of the winners
select their business for gift cards. It connects readers with advertisers
in the most direct way possible, and promotes "shop local" during an
important time of the year for holiday shopping. Collectively, we purchase
50 $20 gift cards from local businesses in our market that support this
section. It spreads the money around in the community while promoting
these local businesses. It's a win-win and continues to grow in support
and participation year after year.
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SELLING FEATURE

10 BENEFITS
OF ADDING PRINT ADVERTISING
TO YOUR MARKETING MIX
Reprinted with permission from the 5 Star Marketing & Distribution Blog at: 5starupnorth.com/blog

Y

ou may have heard that
print is obsolete and that the
only effective advertising is
digital.
But by believing these myths, you
limit the success of your marketing
strategy. According to a study by the
International News Media Association, print advertising itself has
the ability to increase ROI by up
to 240 percent. Print brings some
specific advantages that are irreplaceable by other media. Here are
10 benefits of including print advertising in your business’s marketing
strategy.

10 BENEFITS
OF PRINT ADVERTISING
1. Print targets advertising to a
relevant audience.
Digital marketing often casts a
wide net to include a largely inattentive audience. However, print
marketing, such as advertisements
placed in magazines, is targeted to
an audience who is already interested in your type of business. For example, readers who subscribe to Up
North Action magazine or pick it up
from one of our racks are looking
for travel information pertaining to
northern Wisconsin and Upper Peninsula Michigan. Advertisers in the
lodging, dining, events, and attractions sectors know that they have
a captive audience. What’s more,
magazines such as Up North Action
and Up North Home Showcase enjoy
a loyal readership, so placing an
advertisement in multiple issues of a
magazine increases brand familiarity
and likelihood of sales.
20
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2. Advertising in print offers
flexibility and cost-effectiveness.
Print advertisements are budget-friendly due to their flexibility.
Many small businesses are priced
out of placing TV ads. Radio isn’t
always appropriate. There are limited options in digital advertising. But
there is likely a print ad that fits your
budget. For example, 5 Star Marketing & Distribution sells full-page ads
on coveted spots such as Up North
Action and Up North Home Showcase
magazines’ back covers to companies
wanting the most visibility. 5 Star
offers fractional-page advertisements
with interior placement to those
seeking the most affordable options.
3. Reading print boasts better
attention and retention.
Studies show that people scan a
website for approximately 15 seconds, on average, before moving
on. That is a tiny window of time to
make a big impression! But you have
people’s attention for longer when
they’re reading print.
• Research shows that people read
more slowly when reading text
on paper than when reading a
web page.
• Studies also show that readers
achieve higher rates of recall and
retention when reading print as
compared to digital.
4. Print provides a multisensory
experience for maximum
emotional impact.
Reading a magazine engages several senses:
• Seeing the vibrant colors pop from
the page

• Feeling the weight and texture of
the paper as you hold the magazine
• Hearing pages flip or crinkle as
you turn them
• Even smelling the ink
These impressions enrich readers’
experience with your advertisement,
thereby creating emotional connections and deepening memories of
what they saw and read.
5. Print ads reach many readers
over time.
When your readers enjoy a magazine article, they clip it out (and
the surrounding advertisements as
well) and refer to it later, or they
pass it along to a friend who might
value it, too. A magazine that sits in
a doctor’s office waiting room, gym,
or hotel lobby will be seen by many
people over several months. Rather than getting lost in the fleeting
world of cyberspace, where even
permalinks are frequently broken,
your print ad has staying power in
the physical world.
6. What is printed is perceived
with higher credibility and trust.
As paper and ink are solid and
tangible, print advertising is often
perceived as being more believable
and more influential than digital ads.
On a print ad, the “fine print” may be
small, but it is there in plain sight,
rather than requiring a reader to click
through a labyrinthine website in
order to find it.
7. Unlike digital ads, print ads
stay safe and unobtrusive.
Digital ads that pop up and float
around a web page, covering the

SELLING FEATURE
content readers are trying to read, are
a nuisance. Some people even install
ad-blocking software to prevent ads
from popping up on their screens.
Other online readers may see an ad
that interests them, but they avoid
clicking it. They are wary of the spam
and viruses that may result from bogus digital ads. These elements simply don’t exist in the world of print
marketing. Ads stay put on the print
page and pose no threat of giving
you a virus.
8. Print suits the “unplugged”
lifestyle of our region.
People who live in or travel to
northern Wisconsin and U.P. Michigan tend to value screen-free time.
Whether it’s in a deep-woods lodge,
on the lake, or on the trails, people
can’t always get online in the remote
Northwoods. Nor do they want to!
Print media, on the other hand, reflects Up North travelers’ values.

“

According to a study by the International News
Media Association, print advertising itself has
the ability to increase ROI by up to 240 percent.
Print brings some specific advantages that are
irreplaceable by other media.

9. Print ads drive readers to
engage beyond the page.
Print marketing is a powerful way
to reach, engage, and build the trust
of your target audience. Print advertisements often lead readers online
to get more information and to make
the purchase. Print, while powerful
on its own, is most effective when
used as part of a multimedia marketing strategy. Print is a great introduction to your products and services;
research has shown that combining
print with other channels increases a
marketing campaign’s overall success.

10. Print enjoys greater
visibility.
Today’s push toward reliance on
digital marketing has created a digital space that is very saturated with
ads. But fewer businesses’ opting for
print marketing today allows companies that place ads in magazines and
create brochures, rack cards, and
other print media to stand out and
be seen. 
Original posting:
http://5starupnorth.com/blog/
benefits-of-print-advertising/

ADDITIONAL RESOURCES
- LINKS TO MORE INFORMATION Linkedin – Article

Media Sales is Tough!
Here's What to Do When Your Salespeople Hit a Slump
By Matt Sunshine
This article deals with the universal sales problem of hitting a sales slump. It provides managers
with some practical advice on how to address the problem with sales reps and help them break
out of this common sales problem.

Hubspot – Blog

60 Key Sales Statistics That’ll Help You
Sell Smarter in 2021
By Aja Frost
This article is all about statistics and offers unique facts and insights that will help you gain
better understanding of salespeople, selling and the world of sales. Prospecting to inside sales,
this provides some eye opening statistics.

Money Crashers – Article

15 Surefire Ways to Increase Revenue in Your Business
by Michael Lewis
This article is a practical check list of ways you can reinvent your business to accommodate
today’s changing customer. Not all of them may be what you need but they will provoke
thoughts and solutions to many businesses.

Smallbusiness.chron.com – article

New Revenue Ideas for Small Newspapers
By Barbara Hazeldon
This article is a refresher in options for revenue boosts for publishers that may have gotten
overlooked. Real word, proven options worth considering.

Lotame Solutions Inc. – article

7 Ways Publishers Can Boost Revenue
Through Multiple Streams of Income
This article examines the digital and data opportunities for publishers including advertising,
audience development, consumer marketing and content development as a means of building
revenue.
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POSTAL UPDATE

POSTAL RATES
TO RISE JULY 10, 2022
BY DONNA E. HANBERY – EXECUTIVE DIRECTOR, SATURATION MAILERS COALITION

O

n April 6, 2022, the United
States Postal Service filed a
notice of change in rates for
Market Dominant products
that would increase the average prices for first-class mail and marketing
mail by an average of 6.5%. The price
adjustment was filed in connection
with previous announcements made
by the Postal Service, and intentions
stated in the Postal Service’s ten-year,
Delivering for America plan, that it
would seek to increase prices in a
“judicious manner”, with increases
twice a year. The Service has consistently stated it is likely to seek the
greatest increases permitted by the
law to recoup losses the USPS has
experienced in the past, adjust to declines in mail volumes and increased
costs. Although mailers continue
to resist these price increases, and
oppose the announced 2 times a year
Postal rate filing schedule, the Service’s proposed rate filing is unlikely
to be rejected by the Postal Regulatory Commission under current law and
PRC regulations.
Accompanying this article is a
chart, reprinted with permission from
the Association of Postal Commerce,
showing the specific rate changes for
the rate category used by many free
papers, known as the Enhanced Carrier Route, saturation flat category.
For free papers that are able to
mail as periodicals using “requester
rates”, or periodical rates, the average
rate increase exceeded 6.5%. Because
the periodical class does not cover
its attributable costs, it is required by
PRC regulation to add an additional
2% on a class basis annually to any
price change to make up for its underwater status. The average increase
for periodicals was 8.54%.
On first blush, the average increases for saturation flat mail look as
high or higher than the CPI Market

Dominant average. Fortunately, however, this price filing included a new
discount that can help saturation flat
mailers achieve a significant reduction in their rates.
The April, 2022 filing, added a
discount of .07 cents per piece for
saturation, high density plus, and
carrier route flats that enter mail in
5-digit containers. A direct container
discount is now available for flats
entered in a manner where they can
be cross docked, and avoid Postal
Service handling.
Any container, including sacks,
pallets, tubs, or trays, that are sorted
to a 5-digit level can qualify for
this additional, substantial 5-digit
container, discount. This discount
recognizes the substantial savings

“
		

Another area where a substantial rate increase was put into place
was on use of Detached Address or
Marketing label or DML card that is
permitted to accompany saturation
flat. The Postal Service has been
pursuing an ongoing practice of
imposing steeper than “average” price
adjustments on the cost of a DML
(a card with a marketing or addressing message on the card). The rate
for a DML will increase from $0.07
per card to $0.08 a card, with an
effective increase of over 14%.
When viewed with the full spectrum
of rate increases, saturation flat mail
and saturation letters did “better” than
other types of marketing mail, taking
into account all available discounts.
Some types of mail, including c arrier

The price adjustment was filed in connection
with previous announcements made by the Postal
Service, and intentions stated in the Postal
Service’s ten-year, Delivering for America plan,
that it would seek to increase prices in
a “judicious manner”, with increases twice a year.

the Postal Service can achieve when
mail is entered in a way where it can
be routed immediately to the DDU,
or the carrier, without handling
at the entry Postal Service facility.
When the 5-digit container discount
is applied to the rates for saturation
mail brought to the DDU the effective increase is reduced from over
8%, to just above 4%. For mail that is
entered at the SCF, the rate increase
is reduced to 2.66%
The Postal Regulatory Commission
is anticipated to rule on the USPS’s
adjustments by mid-May. Once approved, the rate changes will go into
effect on July 10, 2022.

routes flats and high density, saw
increases exceeding 12%. The Postal
Service has made statements in its
presentations on costing and pricing
that it is seeking to recognize differences between saturation shared mail
programs that go to all households
and are sent by a single publisher
or mailer, from mailings entered by
mail service providers that might be
consolidating a number of different customers to achieve ECR high
density or high density plus qualification. The Postal Service claims it
has not seen the savings or benefits
of these cooperative mailings. The
Postal Service has also shared with
JUNE 2022
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POSTAL UPDATE
USPS MARKETING MALL FLATS POSTAGE RATES-ENHANCED CARRIER ROUTE
(USPS Rates for July 10,2022 Implementation)

representatives of SMC that it has
heard our message, and understands
that saturation shared mail program
mailers are dealing with a competitive
market environment, are facing higher
costs with print and changing advertiser demands. It appears the Service
has heard and responded to the SMC
messages, that saturation shared mail
programs are a “different”, more price
sensitive product than other mailings
that might be able to qualify for high
density or high density plus.
24
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The only “winner” in this recent rate
filing was the Postal Service’s own
product, EDDM Retail, a saturation flat
entered at a local, retail postal station.
The previous rate of $0.20 per piece,
was reduced to 18.7 cents, for a 6.5%
rate reduction. In response to mailers
that questioned the Postal Service’s
treatment of its “own product”, as
opposed to mailers that prepare saturation mailings for drop ship entry,
the Postal Service rationalized this
treatment as a promotional effort to

stimulate small business interest in the
mail and to incentivize and encourage
more mailings from local business.
In spite of these higher rate adjustments, SMC continues to pursue
discussions with the Postal Service in
efforts to advocate for a different approach to pricing and a potential new
rate category for mailings that are
entered by saturation shared mailers including free paper publishers,
coupon envelopes or magazines, and
shared mail packages. 

RISING STAR

THE THREE-STRIKE RULE

I

BY CARL APPEN –
ACP RISING STAR
DIRECTOR OF CONTENT &
DEVELOPMENT,
APPEN MEDIA

THE THREE-STRIKE RULE
If you need to postpone
something three times,
it’s probably just not the
right time for it.

t seems like ‘podcasting’ is a
buzzword for news publishers.
That’s a column for another
month. I will save you from
reading about it- for now. Instead I want to share a lesson
I’ve learned from podcasting,
and how our newsroom is
better for it.
I work with our news
budget multiple times a day,
every day. So does everyone
else in the newsroom- our
reporters, editor and graphic
designer. I have a few unique
standards in place to keep the
system working and, importantly, actually helpful to use. One of
them is called the three-strike rule,
and I learned it from Cadillac Jack.
Caddy was a morning show host
on Atlanta’s country station for two
decades. You can not find someone who is more of an industry
expert than Caddy. Except for his
wife Donna. I have produced their
show, Cadillac Jack: My Second Act
for about eighteen months now.
That means I’ve recorded about 200
episodes with Caddy and Donna,
spending hundreds of hours in the
studio. In that time I have picked up
countless industry tips and tricks that
are specific to radio, but applicable
to life. Learning from them makes me
a better producer. It also makes me
a stronger leader in our newsroom,
a sharper editor when engaging with
our audiences, even a better host
when it comes to live events.
Caddy puts a ROS (Run-of-Show)
together for every show. It’s sort of
a living document. It has a list of
segments, scripts, sponsor reads, important information for each day’s episode. As the recording session moves
forward, segments will be cut or added, people will call in, and the end
result will look a lot different than
the initial ROS. After the show comes
out, Caddy sits down and prepares

the next ROS. He will pull more information, rewrite copy, or swap out
certain sponsor reads. Sometimes he
will move segments to the following
day that were cut in that day’s episode. But he only does it twice. The
third time a segment is ‘pushed,’ it
goes straight to the trash. Caddy’s lesson is that “if it wasn’t right, or good
enough, or funny enough for the first
two shows, it probably isn’t right, or
good, or funny.”
I follow the same rule with our
reporters. If you move an item to a
different week three times, then on
the third push it has to come off the
budget. It doesn’t always mean that
it was a weak news piece or that we
didn’t have the sources. Sometimes
it’s just not the right fit. One concession that I make (and that Caddy
would approve of) is that you are
allowed to remove an item from the
budget and add the same thing right
back on. There are certain scenarios
where a great story needs to be reassigned four times. But you need the
three strike rule to separate it from
those that just need to come off for
good. It seems silly, but it works. 
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THE LEADERSHIP INSTITUTE

The Leadership Institute
is a structured, industry
specific sales and
management training
program sponsored by the
Association of Community
Publishers.

Association of Community Publishers

OVER THE LAST
15 YEARS

2,457

INDUSTRY PROFESSIONALS
HAVE PARTICIPATED

15,979

CLASS CREDITS HAVE BEEN
AWARDED

140

CERTIFIED ADVERTISING
EXECUTIVE CERTIFICATIONS
AWARDED BY ACP

103

DIFFERENT CLASS
CURRICULUMS PRESENTED
26

|

JUNE 2022

“

Money isn’t everything
but it ranks right up
there with oxygen.

D

—Zig Ziglar
BY JIM BUSCH

uring my career, I had the good fortune to
hear Zig Ziglar speak on several occasions.
Ziglar was an amazing speaker and writer, he affected “a poor country boy” image
but, he was a sophisticated thinker. I have read all
of his books, including the ones unrelated to sales.
One of my favorites is “Conversations with my Dog.”
This book details the “conversations” he had with
Taffy, his Welsh corgi. He uses this literary device
to share his personal philosophy about faith, love,
life, and business. Ziglar was a religious man who,
though he became quite wealthy, was not motivated
by money. He looked upon money as a tool; a tool
that could be used for good or evil. He understood
the importance of maintaining a positive cash flow.
In our business, it’s revenue that keeps the lights on,
and the printing presses running. We need money
to continue helping our customers, and serving our
communities. Our customers also need a steady
revenue stream which means they need a steady
stream of customers coming through the door. It’s
our job to entice those customers to visit our customers. Those local shoppers spend their money at
these local businesses to get the things they need.
It’s like one of those PBS shows about how ecosystems function—if we remove the wolves, the elk
population increases and eats all the grass turning
the land into a desert and the birds, the insects, and
everything dies. Zig Ziglar likened money to oxygen, and this is a good analogy, without oxygen we
would die, and without revenue our businesses will
die. I had a salesperson who wasn’t afraid to make
cold calls and had strong presentation skills yet,
he struggled to make his quota. He choked when
it came to asking for the order. He was certain that
his prospect would balk at spending the amount of
money required to properly promote their business.
The truth is, that HE thought the program was too
expensive. He forgot that, by definition business
people are willing to spend money. If they were
unwilling to spend money, they would never have
gone into business—they would work for someone
else who was willing to spend money to go into
business. He didn’t know what Zig knew, without
revenue our business and our client’s businesses
will suffocate! 

AD-LIBS

HOW TO MAKE A GOOD
SECOND IMPRESSION

D
BY JOHN FOUST
GREENSBORO, NC

on, who manages his newspaper’s sales department, is
always looking for ways to
strengthen customer relations.
“We understand the importance of first
impressions,” he told me. “Know something about the prospect’s business
before calling. Show up for the first
appointment with a big smile and a
firm handshake. Ask questions to learn
about their overall situation and their
marketing goals.
“All of that is important,” he said.
“But what about second impressions?
I’ve been hearing a lot about that lately.
We all know from personal experience
what it’s like to for a salesperson to
treat us like royalty during an initial
meeting, then act like they barely know
us after that – especially if we don’t buy
something right away. That’s why the
things we do in that second contact can
make a big difference in the salesperson-customer relationship.”
Here are some ideas:
1. EXPRESS APPRECIATION IMMEDIATELY. “A good old-fashioned
‘thank you’ is a must,” Don said. “Simply thank them for taking the time to
meet with you. An email is faster, but a
handwritten note is more memorable.”
2. EMAIL A SUMMARY OF YOUR
MEETING. “This can save a lot of
headaches down the road,” Don explained. “The more you discussed in
your first conversation, the greater
the need for a summary. For example, here’s a short version of what
you could say: ‘Thank you for taking
some time to meet with me to discuss
marketing ideas for your company. We
discussed: Point 1, Point 2 and Point 3.
The next step is for me to provide you
with a detailed proposal by the end of
next week. Looking forward to our next
conversation.”

3. SEND BUSINESS-RELATED
INFORMATION. “Obviously, this can
be related to your conversation,” he said.
“For example, if you talked about zoned
coverage or click rates, send more details.
If you can do a little online research, find
some relevant ads that worked well for
a similar business in another market. Or
maybe you can find a couple of famous
ads for national brands, which your prospect could find interesting. Make sure they
illustrate advertising principles that can
help his or her business.”
4. SEND NON-BUSINESS INFORMATION. If you learned that he is a golfer,
email a link to an interesting video about
golf. If she mentioned that her family is
planning a vacation to Europe, send a
related link or clipping from your paper’s
archives.
5. ASK FOR MORE DETAILS ABOUT
THE THINGS YOU DISCUSSED. For
example, if you’re working on a marketing
proposal, do you need more information
about prospective target audiences? Would
you like to have more statistics on sales of
their seasonal products? Would it help to
have a list of loyal customers who could
be willing to provide testimonial quotes?
“It’s smart to ask questions at this point,”
Don said. “It helps you learn more and it
keeps the client engaged in the development process.
Don’s ideas make a lot of sense. A salesperson has only one chance to make a
second impression. 
(c) Copyright 2022 by John Foust.
All rights reserved.
John Foust has conducted training
programs for thousands of newspaper
advertising professionals. Many ad departments are using his training videos to
save time and get quick results from inhouse training. E-mail for information:
john@johnfoust.com
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Graphic Hooks

I am in a camera club... and at times,

By Ellen Hanrahan

the color images that we take are actually
better in black and white.
In my early years of publishing, color
photos on the pages required the advertiser to pay an additional fee, hence most
of our photos were black and white and
the simplest way to do that was to select
Image > Mode > Grayscale.
But software is more sophisticated and
there are alternate ways to get better black
and white images.

Black & White Conversions

I chose this image (el Dia los Muertos,
Mexico) because the tone/values were
similar in the background and the woman
facing the camera.

Image > Mode > Grayscale applied to
original (also destructive) and although
there is more contrast, I am losing some
details. When I chose Mode, I also got a
dialog box asking if you want to discard
the color information— this is why it’s considered destructive because you will not
be able to get the color information back
(it also directs you to the appropriate setting if you want to control the conversion).

hanrahan.ln@att.net ©06/2022

A Better Black and White

Creating an Adjustment Layer allows me
to save the original image with layers if I
ever need to go back and alter some of the
settings or create “batch” processing data.
The other two methods— Desaturate and
Grayscale— do not offer that option.
So here are the steps I took for my final
black and white image:
To start the process, select Window >
Adjustments and click on the Black and
White icon ( 2nd row, 3rd choice). I then
selected the Properties panel and it brings
up a list of Presets. The first one is Default
(naturally), but click on the little arrow
to see many other choices— Blue Filter,
Darker, Green Filter, High Contrast Blue,
High Contrast Red, Infrared, Lighter and
five more. I also have sliders within that dialog box to further customize my choices. I
chose Darker.
The sliders adjusted to the preset I
chose. Slide to the left, it’s darker, slide to
the right it’s lighter. I also found that it’s
pretty easy to figure out (probably developed with me in mind).
I moved the sliders: Reds to 65, Yellows
to 35 and Greens to 0.
I went and adjusted the Levels ever so
slightly (I moved the light arrow from 255
to 246). I saved the file as a Photoshop file
before I flattened the image and saved as
a JPEG. My final step was to go to Filter >
Sharpen > Unsharp Masking before placing on this page.

Black and White Review

Image > Adjustments > Desaturate
applied to original (destructive) but not
too bad. Details are still visible.
28
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Window > Adjustments is an option that
allowed me to create a more dynamic
black and white image. I was able to create more depth in the background while
maintaining the details in the model’s face.
Granted, it took me a wee bit longer,
but I can go back to my original image and
make more adjustments if I need (or want).
I can also save my settings as “custom” if
I have a number of similar images that I
want to change to black and white.

All three black and white images are not
bad. However, most of the ads I did were
printed on newsprint and that is a very
porous substrate… plenty of dot gain!
Granted, image editing software has
made the job easier and I wish we had had
the ability to create more dynamic black
and white images “back in the day.”
Color images can help define specific
areas, but it’s not always available to the
designer. My final black and white image
does add a little more depth to the image
while maintaining details to focus on the
model, making it my better choice.

Final Thoughts…

Wow, this is for the June issue and there are
still lots I have to do… hopefully this will be
a productive month for me! Also, Adobe
has announced that color swatches from
Pantone, will be removed from a number
of Creative Suite professional design products, leaving a lot of us confused about the
consequences of that decision. I guess I
have a lot more research to do!

Community Publications Business and Service Directory
CREATIVE SERVICES

ADVERTISING SERVICES & SOLUTIONS

● PRINT DESIGN

● LOGO DESIGN

● WEB AD DESIGN

● PAGINATION

● BILLBOARD DESIGN

● CUSTOM SOLUTIONS

855-614-5440
APPRAISALS & BROKERING
Newspapers
Magazines - Shoppers
Book Publishing

DIGITAL SOLUTIONS FOR PUBLICATIONS

WWW.TCSDIRECT.COM

CUSTOMER RELATIONSHIP MANAGEMENT
ARE YOUR MEDIA SALES…

DIRECT MAIL AND PRINTING

HELP YOUR TEAM…

Confidential
Customized - Comprehensive

KAMEN & CO. GROUP SERVICES
516-379-2797 WWW.KAMENGROUP.COM
For more information - see our ad in this issue.

ASK-CRM is a newspaper-centric CRM
designed to maximize your sales efforts.
robin@ask-crm.com, 301.800.2275, www.ask-crm.com

AUDIT & READERSHIP STUDIES

CVC Audits and
Readership Studies
Third Party Print & Digital Verification
Increased Exposure to Media Buyers
Learn What Your Readers Want

Call 800-262-6392 or visit www.cvcaudit.com
CIRCULATION SUPPLIES

Your trusted source for
circulation supplies
Poly Bags - Rubber Bands

Event Bags - Bundle Rain Covers - Carrier Bags
Contact us at:

800.634.0017

sales@pdisaneck.com
fax: 614-890-0467

CONTENT AND DATA MANAGEMENT

Digital Publishing Solutions For
News and Media Organizations
www.townnews365.com

800-293-9576

Online Solutions.
Bottom-line results.
COMMUNITY PUBLISHER NEWS

Keeping the industry informed...
one issue at a time.

DIGITAL GROWTH PROGRAM
Digital Growth Program

Helping small to mid-sized
news organizations grow
their digital businesses with
free playbooks, workshops,
and interactive exercises.

E-COMMERCE CLASSIFIED SOLUTIONS

BLUEFIN PLACE AD

THE BEST SELF-SERVICE AD PLACEMENT
SOLUTION AVAILABLE TO PUBLISHERS

978-662-3323

WWW.GETBLUEFIN.COM

g.co/gnidigitalgrowth

DIGITAL MARKETING

FRESH AIR FOR DIGITAL MARKETING

EDITORIAL RESOURCES

High-Quality,

Free Print & Digital Content
WE DO THE SALES & OPERATIONS
HEAVY LIFTING

New digital revenue in 90-days

Proven go-to-market approach
3 to 5 x margin

Food and Recipes
Lifestyle and Health
Home and Garden
Visit familyfeatures.com or contact Cindy Long @ 913-563-4752

DIGITAL REVENUE CONCEPTS

START A BUSINESS DIRECTORY WEBSITE

ENTERTAINMENT CONTENT
Providing its partners with free entertainment
content from our stable stable of publications,
including TV Guide, TV Weekly, Channel Guide,
HOPPER, and ReMIND magazine.

Perfect add-on to your Wedding & Home
Improvement Special Sections

www.idealdirectories.com

From the owners of Page Flip Pro & SiteSwan
DIGITAL SALES TRAINING

888-584-6688 ntvbmedia.com/edge

✶
✶
✶
✶
✶
✶
✶
✶

ASK MATT
CHEERS & JEERS
MOVIE REVIEWS
CELEBRITY INTERVIEWS
BEHIND THE SCENES
DAILY BEST BETS
DID YOU KNOW?
ReMIND ReWIND

LEGAL & PUBLICE NOTICE AUTOMATION

Your Legal Notice Experts
LEGAL
NOTICE
SERVICE

INCREASE YOUR DIGITAL MARKET SHARE
HANDS-ON DIGITAL SALES TRAINING
800-917-0820
info@sparkdigitalsalesgroup.com

Our proprietary system automates the entire
process, saving time, money, and manpower.
866-672-1600
info@legalnoticeservice.com

Your Go-To Guide for Community Publication Business and Service Support
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YOUR LISTING HERE

EDITORIAL
RESOURCES
NETWORK
CLASSIFIED
ADS

Deliver Your Message To
Over 7,000,000 Homes

This Space Available

Formerly the NANI and CADNET Networks

MAILROOM CONTROL SYSTEMS

PAID CONTENT

PUBLISHING SOFTWARE
FULLY INTEGRATED
EASY TO USE
AFFORDABLE
FREE DEMO

DIRECT MAIL
COMMERCIAL BILLING
GENERAL ACCOUNTING
PAYROLL

603-323-5077 WWW.MERRSOFT.COM
PUBLISHING SOFTWARE

THE NEWSPAPER MANAGER
www.miracomcomputer.com

The leader in US Newspaper
Mailroom Controls.

CRM SALES PRODUCTION BILLING
INTEGRATED MARKETING

888-3069-0639 (x83)
www.miracomcomputer.com
YOUR LISTING HERE

Ph: 706-750-0016 gbooras@mirbeltechnologies.com
www.newspapermanager.com

PRINTING AND PROMOTIONAL SUPPORT

This Space Available

800-270-1769
MEDIA CONSULTING

Design. Content. Ideas.
Software. Training.
Providing the knowledge,
experience and technology to
help publishers grow and thrive!

•
Creative Circle
MEDIA SOLUTIONS

YOUR LISTING IN THIS SPOT

PUBLICATIONS PRINTING

✔ MAGAZINES
✔ JOURNALS
✔ CATALOGS

800-647-0035

✔ GUIDEBOOKS
✔ HIGH QUALITY
✔ SHORT-RUN PUBLICATIONS

CUMMINGSPRINTING.COM

SOFTWARE SYSTEMS FOR PUBLISHERS

This Space Available

401-455-1555
www.creativecirclemedia.com

MEDIA SELLER SOLUTIONS

PRINTING - FULL SERVICE

Premium visibility packages deliver your
information where media decisions are made!

Newspapers * Publications * Shoppers
Catalogues * Magazines * Directories * Coupn Books

SRDS Solutions for Media Sellers

SOFTWARE SYSTEMS FOR PUBLISHERS

INNOVATION. LONGEVITY. SERVICE.

Find out why our customers call us
“the best tech support team”
and say “we wish we could contract with
SCS to support all our products.”

205 Spring Hill Road, Trumbull, CT 06611

847-375-5000

❖

srds.com

203.261.2548

www.trumbullprinting.com

MERCHANT CARD PROCESSING

PRINTING FOR PUBLISHERS

Payment Processing

WE PRINT FOR PUBLISHERS.

SPECIAL SECTIONS DONE RIGHT

DIRECT MAIL - MAGNET MAILERS
AUTO DEALER MAILERS
Contact us today!

715.273.4601 - 800.533.1635

msgpay.com/publishing

phil@newspapersystem.com

Contact the AFCP Office
at 877-203-2327
800-568-8006
to find out more about this member benefit!

info@helmerprinting.com
www.helmerprinting.com

Nate Sanders
303-944-5699

Jeff Martoz
303-435-9161

pubprinters.com

Your Go-To Guide for Community Publication Business and Service Support
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Are you taking full advantage
of all your acp member benefits?
Here are just a
few to consider...

NEW HIRE
SALES TRAINING
The eight class sequence available in
the On Demand Training Center provides
a great way to train incoming sales hires
in the basic process of publication
advertising sales right in the
convenience of your own office.

INDUSTRY
CONFERENCES AND
LEADERSHIP SUMMITS

NETWORKING
OPPORTUNITIES

These in-person ACP events are “The”
networking, educational and social
events of any year. They can include
speakers, training, the industry’s
largest trade show and are sure to
include plenty of networking, idea
sharing, and much more.

ON DEMAND
TRAINING
CENTER

Association of
Community
Publishers

CIRCULATION
AUDITS
Circulation audits bring
credibility to community
publication circulation and
provide an accurate picture
of a publications readership
and verified market penetration.

ACP serves the industry by acting
as a facilitator to connect members.
Whether it’s advice, answers to
questions or sharing ideas, let us
help connect you!

MEMBER
BENEFITS

BEST OF THE BEST
PUBLICATION AWARDS
Be recognized as the Best of the Best!
The annual awards competition gives
you the opportunity to gain the
national recognition that you and your
staff have earned and deserve.

ACP’s newest member
benefit - online training
for media professionals
that is extensive, effective
and available 24/7 to
meet everyone’s training
schedule.

THE LEADERSHIP
INSTITUTE (TLI)
TLI is a structured, comprehensive,
cost effective sales and leadership
training program that was designed
specifically for ACP members and
the free paper industry.

RISING STARS
PROGRAM
This program is designed to honor
young individuals who are emerging
leaders in the community publishing
industry. It offers specialized training
and benefits to those selected.

Providing the tools and support needed for
your publications to be more successful.
Not a member...join today! 877-203-2327 or communitypublishers.com

Publish
Association of
Community
Publishers

PRSRT STD
U.S. Postage
Paid
Permit #22
Slayton, MN

5701 E. Circle Dr. - #347
Cicero, NY 13039-8638

Publish is a monthly magazine
produced by the Association
of Community Publishers.
The mission of Publish is to
cover the people, companies
and events that shape the
community media industry one issue at a time.

Your long term key to revenue growth is here!
NOTHING TOPS A
STRONG SALES TEAM

HRS

N DEMAND
TRAINING CENTER

A MEMBER BENEFIT OF THE ASSOCIATION OF COMMUNIT Y PUBLISHERS

8 Session Hew Hire Training Sequence
140 General Sales Training Modules
Internet Access From Home or Office
FREE to all ACP Members

Available when you are...
all day, every day!
ACP Members go to:
www.communitypublishers.com/members-only-access

Association of
Community
Publishers

